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Manuel de mise en service

Memobase CYZ41D
Logiciel pour la gestion centralisée des données et des capteurs
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1 Memobase

1. 1 Caractéristiques
Memobase est un logiciel permettant la gestion centrale des données et des capteurs pour les 
systèmes Memosens. 

Il permet la documentation de bout en bout des données relatives à vos capteurs et points de 
mesure, par ex. :
• Historique des étalonnages
• Données de fonctionnement des capteurs, comme la durée totale de fonctionnement, la durée de 

fonctionnement sous des conditions de process extrêmes
• Affectation à un point de mesure ou à un groupe de points de mesure

Memobase repose sur une architecture client-serveur et permet l'accès de plusieurs clients. Toutes 
les données sont stockées dans une base de données centrale.

Le logiciel peut être combiné aux bases de données suivantes :
• SQLite

Vous pouvez installer la base de données SQLite se trouvant sur le CD Memobase fourni et 
l'utiliser en local sur votre ordinateur.

• ODBC
Si vous utilisez déjà une base de données ODBC, vous pouvez utiliser celle-ci. Pour cela, les 
drivers ODBC correspondants pour Oracle doivent être installés sur votre ordinateur et un client 
de base de données correspondant doit être réglé sur votre ordinateur. Adressez-vous à votre 
administrateur de base de données.

Toute utilisation différente de celle décrite ici compromet la sécurité des personnes et de l'ensemble 
du système de mesure et n'est donc pas autorisée.
Le fabricant ne peut être tenu pour responsable en cas de dommages résultant d'une utilisation non 
conforme ou inappropriée.

1. 2 Configuration requise
Pour l'installation et l'utilisation de Memobase, la configuration requise est la suivante :

• Système d'exploitation : Windows 2000 SP4 ou XP SP2
• Au moins 100 Mo d'espace mémoire sur le disque dur
• Commubox FXA291 

Vous trouverez les informations pour le raccordement et l'installation de la FXA291 dans 
l'Information technique TI405C et sur le CD d'installation de la FXA291.

• Appareil de laboratoire Liquiline 
CM42-M/N*********, version de software 10.04.05 ou plus

• Adobe Reader 7.0 ou plus
Pour afficher le manuel de mise en service (également nécessaire si la version complète d'Adobe 
Acrobat est installée)
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2 Identification

2. 1 Structure de commande

2. 2 Contenu de la livraison
La livraison comprend :
• CD d'installation avec Memobase Setup et manuel de mise en service
• Numéro de série et numéro de licence
• Instructions condensées 
• Commubox FXA291 (en option)

Logiciel
1 Standard

Version
1 Standard

Diagnostic
A Standard

Interface
1 Non sélectionnée
2 FXA291

Langage de la documentation
D Allemand / anglais

Equipement complémentaire
1 Non sélectionné

CYZ41D-
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3 Installation

3. 1 Assistant d'installation
L'assistant d'installation vous guide pour l'installation du logiciel Memobase. Il comprend également 
la fonction de mise à jour. Donc si vous voulez mettre à jour votre logiciel Memobase, lancez 
l'assistant d'installation.

1. Insérez le CD dans votre lecteur de CD/DVD.
L'installation de Memobase démarre automatiquement. 
Si l'autostart n'est pas actif, lancez MemobaseSetup.exe directement à partir du CD.

2. Dans la fenêtre de dialogue qui s'affiche, sélectionnez la langue souhaitée.
Cliquez sur OK.

3. La licence d'utilisation apparaît.

– Veuillez lire attentivement les termes de cette licence.
– Cliquez sur Accepter pour accepter les termes de cette licence et pour continuer 

l'installation.
– Cliquez sur Annuler si vous n'acceptez pas les termes de cette licence et si vous souhaitez 

interrompre l'installation.

4. Dans la boîte de dialogue qui apparaît, entrez le numéro de série se trouvant au dos de la 
pochette du CD.

Cliquez sur Suivant.
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5. Entrez le numéro de licence. Il se trouve également au dos de la pochette du CD.

Cliquez sur Suivant.

6. Indiquez le répertoire dans lequel Memobase doit être installé.

Par défaut, Memobase est installé dans le répertoire suivant :
C:\Program files\Endress+Hauser\Memobase
Si vous voulez installer le logiciel dans un autre répertoire, cliquez sur Parcourir et 
sélectionnez le répertoire désiré.
Cliquez sur Installer pour lancer l'installation.

7. Dans la fenêtre de dialogue Database installer, sélectionnez le type de votre base de données 
et indiquez les informations nécessaires concernant votre base de données.
• Si vous utilisez Memobase en local avec la base de données SQLite fournie : 

– Sélectionnez SQLite dans Database type.
– Entrez le répertoire dans lequel la base de données doit être installée. 

Par défaut, la base de données SQLite est installée dans le répertoire suivant :
C:\Program files\Endress+Hauser\Memobase
Si vous voulez installer la base de données dans un autre répertoire, indiquez le répertoire 
souhaité.
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• Si vous utilisez une base de données ODBC :

– Assurez-vous que les drivers ODBC correspondants pour Oracle sont installés sur votre 
ordinateur et qu'un client ODBC est réglé. Si nécessaire, adressez-vous à votre 
administrateur de base de données.

– Sélectionnez ODBC dans Database type.
– Entrez vos données d'accès pour la base de données.

Cliquez sur Installer pour poursuivre l'installation.

8. Selon le type de base de données choisi, les boîtes de dialogue suivantes s'affichent :
– Si vous créez une nouvelle base de données SQLite, la fenêtre de dialogue Create new 

database s'ouvre.
Cliquez sur OK.
Les fichiers de Memobase et la base de données sont copiés dans le répertoire cible.

– Si vous mettez à jour une base de données ODBC existante, la fenêtre de dialogue Update 
existing ODBC database s'ouvre.
Cliquez sur OK.
Les définitions de Memosens et les textes sont actualisés.

9. Cliquez sur Terminer dans la boîte de dialogue affichée pour terminer l'installation.
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4 Configuration

4. 1 Lancer le programme
1. Assurez-vous que les drivers de la Commubox FXA291 sont installés sur votre ordinateur 

conformément aux instructions.

2. Assurez-vous que la Commubox FXA291 est raccordée à un Liquiline et au port USB de votre 
ordinateur.

3. Sélectionnez Start > Programs > Memobase > Memobase.

4. La fenêtre de connexion apparaît :

Si vous lancez Memobase pour la première fois :
– Laissez Administrator comme nom d'utilisateur
– N'entrez pas de mot de passe. 

Vous définirez plus tard les noms d'utilisateur et les mots de passe dans le logiciel.
Pour les démarrages suivants :
– Entrez votre nom d'utilisateur.
– Entrez votre mot de passe.
Cliquez sur Login.

5. La boîte de dialogue Modem selection s'ouvre.

– Sélectionnez le port COM auquel la Commubox FXA291 est raccordée.
– Cliquez sur OK.

6. La connexion avec le Liquiline est établie.
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7. L'interface utilisateur du Memobase s'ouvre.

4. 2 Communication

4.2.1 Connecter la Commubox FXA291
Si le Liquiline est raccordé à votre ordinateur lorsque vous lancez Memobase, la connexion s'établit 
automatiquement lors du démarrage du programme. 

Si Liquiline n'est pas raccordé à votre ordinateur, procédez de la façon suivante :

1. Connectez la prise USB de votre Commubox FXA291 à un port USB de votre ordinateur.

2. Sélectionnez Communication > Connect Commubox FXA291.

3. Dans la boîte de dialogue Modem selection, sélectionnez USB Commubox FXA291 Serial 
Port. Cliquez sur OK.

4. La connexion avec le Liquiline est établie.
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4.2.2 Appel automatique du Liquiline
L'appel automatique permet de sauvegarder automatiquement dans la base de données Memobase 
tout étalonnage effectué sur le Liquiline raccordé.

L'appel automatique du Liquiline est activé par défaut. 
Par conséquent, si vous étalonnez un capteur sur le Liquiline et prenez les données d'étalonnage 
pour l'ajustement, les données d'étalonnage sont transmises au capteur et à la base de données 
Memobase. Un nouveau bloc de données avec les nouvelles données d'étalonnage est créé 
automatiquement.

Si l'appel automatique du Liquiline n'est pas activé, procédez de la façon suivante :

1. Sélectionnez Communication et cliquez sur Autom. Liquiline polling. Une coche apparaît 
à côté d'Autom. Liquiline polling et un point vert dans la barre des tâches . 

2. Pour désactiver l'appel automatique, sélectionnez à nouveau Communication et cliquez sur 
Autom. Liquiline polling.
La coche à côté d'Autom. Liquiline polling disparaît et un point gris apparaît dans la barre 
des tâches.

4. 3 Personnaliser l'interface utilisateur

4.3.1 Sélection langue
Memobase est disponible en anglais et en allemand. La langue de l'interface se change facilement si 
un autre utilisateur souhaite utiliser la base de données dans une langue différente.

Pour changer la langue :

1. Sélectionnez Options > Set language.

2. La boîte de dialogue Language selection s'ouvre.
– Sélectionnez la langue souhaitée pour l'interface utilisateur, par ex. l'anglais.
– Cliquez sur OK.

3. Memobase passe à la langue sélectionnée.
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4.3.2 Visualiser les données capteur
Vous pouvez configurer individuellement l'affichage des données capteur pour avoir toujours 
directement à portée de main les informations que vous souhaitez.

Pour adapter l'affichage :

1. Sélectionnez Options > Preferences.

2. La boîte de dialogue Preferences s'ouvre.

– Sous Preferences for sensor, sélectionnez le type de capteur pour lequel vous voulez 
configurer l'affichage.
Pour les électrodes en verre, sélectionnez CPSx1D. Pour les capteurs ISFET, sélectionnez 
CPS4x1D.

– Sélectionnez l'onglet de la vue que vous voulez configurer, Sensor view, Sensor user 
data, Database ou Statistics.

– Sélectionnez les données capteur que vous voulez afficher.

! Remarque ! 
Vous pouvez restaurer les réglages par défaut à tout moment. Pour cela, cliquez sur 
Defaults.

– Une fois que la vue correspond à vos attentes, cliquez sur Close.

3. Les données capteur activées sont affichées, les données désactivées sont masquées.
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4. 4 Gestion des utilisateurs
Pour protéger Memobase de modifications accidentelles ou indésirables, vous pouvez limiter l'accès 
à la base de données uniquement à certains utilisateurs grâce à un mot de passe et assigner à ces 
utilisateurs des rôles d'utilisateur. 

Vous pouvez définir les rôles d'utilisateur suivants :
• Opérateur

En tant qu'opérateur, vous pouvez enregistrer de nouveaux capteurs Memosens dans Memobase 
ou modifier des blocs de données enregistrés et les sauvegarder comme nouveau bloc de données 
avec un nouvel horodatage. Toutefois, vous ne pouvez effectuer aucun changement dans la 
gestion des utilisateurs et dans l'affectation des points de mesure.

• Spécialiste
En tant que spécialiste, vous avez les mêmes droits que l'opérateur. Mais vous pouvez en plus 
gérer l'affectation des points de mesure. Vous ne pouvez toutefois pas intervenir dans la gestion 
des utilisateurs.

• Administrateur
En tant qu'administrateur, vous avez les mêmes droits que le spécialiste. Mais vous pouvez en 
plus archiver les données et gérer les utilisateurs.

4.4.1 Créer, éditer, supprimer des utilisateurs
Pour configurer la gestion des utilisateurs, procédez de la façon suivante :

1. Sélectionnez Options > User administration.

2. La boîte de dialogue User administration s'ouvre.

Pour créer un nouvel utilisateur :
– Cliquez sur Add user.
– Entrez le nom d'utilisateur souhaité.
– Affectez un rôle d'utilisateur à cet utilisateur.
– Entrez le mot de passe, puis entrez-le une seconde fois.
Pour éditer un utilisateur existant :
– Cliquez sur un utilisateur.
– Cliquez sur Edit user.
– Modifiez le rôle d'utilisateur ou le mot de passe comme vous le souhaitez.
Pour désactiver un utilisateur :
– Cliquez sur un utilisateur.
– Cliquez sur Disable user.

3. Cliquez sur Apply pour sauvegarder les réglages effectués.
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4.4.2 Ouvrir et fermer une session en tant qu'utilisateur
Lorsque vous quittez la base de données Memobase, vous pouvez fermer la session sans avoir à 
fermer la base de données. 

1. Pour cela, sélectionnez File > User logout.

2. La boîte de dialogue E+H Memobase - Login s'ouvre.

3. Un nouvel utilisateur doit entrer son nom d'utilisateur et son mot de passe dans la fenêtre de 
connexion pour pouvoir utiliser la base de données Memobase.

4. 5 Affectation des points de mesure (TAG)
Memobase vous permet d'affecter vos capteurs à un point de mesure défini ou à un groupe de points 
de mesure.
Pour éviter de confondre les capteurs lors du remplacement sur le terrain, vous pouvez - en plus de 
l'identification extérieure avec Memoclip (voir "Accessoires") - activer un contrôle des capteurs 
raccordés dans les transmetteurs de la génération Liquiline. 
On contrôle alors que les capteurs sont affectés au bon point de mesure. Une mauvaise affectation 
déclenche une alarme dans le Liquiline.

Les affectations suivantes sont possibles :
• TAG :

Si vous affectez un TAG à un capteur, celui-ci est lié à un seul point de mesure. Il ne peut être 
utilisé qu'à ce point de mesure et à aucun autre. 
Exemple :
– Le capteur A est affecté au point de mesure TAG 1.
– > Le capteur A ne peut être utilisé qu'au point de mesure TAG 1.

• Groupe TAG :
Si vous affectez un groupe TAG à un capteur, le capteur peut être utilisé à tous les points de 
mesure faisant partie de ce groupe. 
Exemple :
– Le groupe TAG 1 se compose des points de mesure X, Y et Z.
– Le capteur A est affecté au groupe TAG 1. 
– > Le capteur A peut être utilisé aux trois points de mesure X, Y et Z. Il ne peut être utilisé à 

aucun autre point de mesure.
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4.5.1 Affecter des points de mesure (TAG) dans Memobase 
Pour affecter les capteurs que vous gérez dans votre base de données Memobase à un point de 
mesure ou un groupe de points de mesure défini, vous devez établir une liste de TAG ou une liste 
de groupes de TAG.

Procédez de la façon suivante :

1. Sélectionnez Options > TAG assignment.

2. La boîte de dialogue TAG assignment s'ouvre.

Pour créer une nouvelle entrée :
– Sélectionnez l'onglet TAG List ou TAG Group List.
– Cliquez sur New.
– Entrez le nom de TAG ou le groupe de TAG.

Si vous le désirez, vous pouvez entrer un commentaire.
– Répétez les deux étapes précédentes pour chaque nom de TAG ou groupe de TAG que vous 

voulez ajouter à votre liste.
Pour désactiver une entrée :
– Sélectionnez l'entrée que vous voulez effacer.
– Cliquez sur Disable user.

3. Une fois la liste terminée, cliquez sur OK.

4. Vous pouvez à présent assigner à chaque capteur Memosens un nom de TAG ou un groupe de 
TAG. Pour cela, référez-vous au chapitre "Consulter Memosens".

4.5.2 Réglages du Liquiline - Affectation de points de mesure dans 
Liquiline 

Le Liquiline M CM42-M/N********* propose les fonctions suivantes pour la gestion des points 
de mesure :
• Lab device (appareil de laboratoire) : 

Cette fonction permet de s'assurer que les informations sur le point de mesure mémorisées dans 
le capteur ne sont pas écrasées lors d'un étalonnage sur le Liquiline.
Utilisez cette fonction pour les appareils que vous utilisez en laboratoire pour l'étalonnage central 
de capteurs Memosens.

• Sensor check (contrôle des capteurs) (disponible uniquement avec le software "Advanced 
Version") :
Cette fonction permet de déterminer quels capteurs sont acceptés sur le transmetteur Liquiline.
Activez cette fonction pour les appareils utilisés dans le process et auxquels vous voulez affecter 
des capteurs définis.

! Remarque ! 
Les deux fonctions s'excluent mutuellement. Sur un Liquiline, vous pouvez activer soit la fonction 
"Lab device" soit la fonction "Sensor check".
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Lab device (appareil de laboratoire)

Etant donné que les capteurs avec technologie Memosens mémorisent les données d'étalonnage, 
vous pouvez l’étalonner en laboratoire. Pour cela, utilisez un Liquiline et activez la fonctionnalité 
laboratoire. Vous vous assurez ainsi que toutes les informations sur le point de mesure (TAG, groupe 
TAG) mémorisées dans le capteur ne sont pas écrasées. Cela signifie que vous pouvez sans problème 
utiliser à nouveau le capteur étalonné au point de mesure qui lui a été affecté, même si le contrôle 
du capteur a été activé.

Pour activer la fonctionnalité laboratoire dans le Liquiline :

1. Sélectionnez Param > General settings > Sensor check.

2. Sélectionnez On et appuyez sur le navigateur pour confirmer votre entrée.

Sensor check (contrôle des capteurs)

Si vous affectez à votre point de mesure dans le processus certains capteurs, vous pouvez utiliser le 
contrôle des capteurs pour vous assurer que seuls les capteurs assignés ou des capteurs neufs avec 
une référence identique sont raccordés à ce point de mesure. 
Si un autre capteur est raccordé à ce point de mesure, il est rejeté par le Liquiline et une alarme 
s'affiche. 

Pour activer le contrôle des capteurs dans le Liquiline :

1. Sélectionnez Param > General settings > Sensor check. Appuyez sur le navigateur pour 
confirmer.

2. Selon que votre point de mesure est exploité via un groupe de TAG ou un TAG, sélectionnez 
TAG group ou TAG. Appuyez sur le navigateur pour confirmer.

3. Selon le réglage précédemment effectué, sélectionnez TAG number ou TAG group.
Appuyez sur le navigateur pour confirmer.

4. Entrez le TAG number ou le TAG group souhaité. A l'aide du navigateur, faites défiler 
jusqu'à OK et confirmez en appuyant sur le navigateur.
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4. 6 Vue capteur
La vue capteur permet de montrer le capteur actuellement raccordé à votre Liquiline de laboratoire.

Dans cette vue, vous pouvez :
• Consulter les données du capteur actuellement raccordé à votre Liquiline de laboratoire
• Compléter les informations spécifiques du capteur
• Sauvegarder le bloc de données du capteur dans votre base de données
• Affecter un point de mesure (TAG) ou groupe de point de mesure (groupe TAG) défini, 

si nécessaire.

4.6.1 Consulter Memosens
Procédez de la façon suivante :

1. Assurez-vous qu'un capteur est raccordé à votre transmetteur.

2. Sélectionnez l'onglet Sensor view.

3. Cliquez sur Read Memosens.

4. Les données capteur sont consultées.

Si la base de données contient déjà des blocs de données du capteur raccordé, ceux-ci sont 
également affichés.

! Remarque ! 
Les données affichées ne sont pas automatiquement sauvegardées. Pour sauvegarder les données, 
référez-vous au chapitre "Storing data".
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4.6.2 Ajouter des infos capteur
1. Si vous voulez affecter des informations spécifiques au capteur, cliquez sur Open sensor 

information.

2. Les informations capteur sont affichées.

– Si vous voulez affecter le capteur à un point de mesure ou à un groupe de points de mesure, 
cliquez sur la flèche à côté du champ TAG ou TAG group.
La liste TAG ou liste de groupes TAG créée précédemment est affichée.

Double-cliquez sur l'entrée que vous voulez affecter au capteur.
Le TAG ou groupe de TAG assigné est sauvegardé à la fois dans la base de données 
Memobase et dans le capteur.

! Remarque ! 
Les capteurs exploités sur un point de mesure avec un TAG qui n'existe pas encore dans la 
liste de TAG de la base de données, génèrent une entrée automatique dans la liste au 
moment de leur sauvegarde. Vous pouvez ajouter à tout moment un commentaire à 
l'affectation du point de mesure.

– Si vous ne voulez plus utiliser un capteur, vous pouvez le désactiver. De cette manière, vous 
voyez immédiatement qu'il n'est plus intégré au process.
Cochez la case Active. La case est décochée et l'entrée devient No. Le capteur est marqué 
comme inactif dans la base de données.

– Pour entrer un nom de Memoclip, cliquez sur le champ vide à côté de Label Memoclip.
Entrez les informations souhaitées.

– Pour entrer un commentaire, cliquez sur le champ vide à côté de User comment.
Entrez les informations souhaitées.

4.6.3 Sauvegarder les données
1. Cliquez sur Store data.

2. Le bloc de données est sauvegardé avec la date et l'heure d'enregistrement et stocké dans la 
base de données.

! Remarque ! 
Une fois le bloc de données enregistré, il ne peut plus être effacé. Cela protège la base de données 
de toute manipulation.
Si vous effectuez des modifications sur un bloc de données, par ex. en modifiant les infos capteur, 
une copie est créée avec un nouvel horodatage.
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4. 7 Vue base de données
La vue base de données permet d'afficher tous les capteurs mémorisés dans votre base de données.

Pour ouvrir la vue base de données, sélectionnez l'onglet Database pH glass ou Database pH 
ISFET.

Les données sont disposées de la façon suivante :
• Le bloc de données le plus récent se trouve toujours à gauche.
• Dans la zone grisée du haut se trouvent les données du capteur actuellement sélectionné (sur la 

capture d'écran ci-dessus le bloc de données précédent le plus récent).
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4.7.1 Informations affichées
La vue base de données indique par défaut les informations suivantes sur les capteurs : 
• date et heure d'enregistrement (event time)
• Identification

– référence de commande (order code)
– numéro de série (serial number)
– date de fabrication (date of manufacture)
– date de mise en service (commissioning date)
– identification Memoclip (Memoclip label)
– actif (active)
– TAG
– groupe TAG (TAG group)

• Infos capteur (sensor information)
– méthode d'étalonnage (type of calibration)
– point zéro pH [mV] (zero point)
– pente [mV/pH] (slope)
– date d'étalonnage
– tampon 1 [pH] (buffer 1)
– tampon 2 [pH] (buffer 2)
– nombre d'étalonnages (number of calibrations)
– delta point zéro [pH] (delta zero point)
– delta pente [pH/mV] (delta slope)
– numéro de série transmetteur d'étalonnage (S/N calibration transmitter)

• Etalonnage de la température (temperature calibration)
– offset [°C] (temperature offset)
– date d'étalonnage (temp. adjustment date)
– numéro de série transmetteur d'étalonnage (S/N calibration transmitter)

• Infos de service (operating information)
– durée de fonctionnement [h] (operating hours)
– nombre de stérilisations (number of sterilizations)
– température de service max. [°C] (max. operating temperature)
– utilisation > 80 °C [h] (usage > 80 °C)
– utilisation > 100 °C [h] (usage > 100 °C)
– utilisation < -300 mV (usage < -300 mV)
– utilisation < 300 mV (usage < 300 mV)

• Infos spécifiques (customized sensor information)
– nom de l'utilisateur (user name)
– rôle de l'utilisateur (user role)
– commentaire de l'utilisateur (user comment)



Memobase CYZ41D Configuration

Endress+Hauser 21

4.7.2 Opérations dans la vue base de données
Dans cette vue, vous pouvez :
• Filtrer et trier les entrées de la base de données
• Traiter les infos capteur
• Ouvrir les statistiques graphiques.

Filtrer et trier

1. Pour filtrer et trier vos données, cliquez sur Search.

2. La boîte de dialogue Search s'ouvre.

– Sous Global filter, vous déterminez si tous les capteurs ou seulement les capteurs actifs 
doivent être pris en compte lors de la recherche.

– Dans Event time filter, vous indiquez la période sur laquelle la recherche doit être 
effectuée.

– Dans Detail filter, vous déterminez les caractéristiques des capteurs selon lesquelles les 
entrées de la base de données doivent être filtrées. Dans le champ du haut, sélectionnez la 
caractéristique de capteur, par ex. numéro de série ou TAG, et entrez dans le champ du bas 
les données appropriées, par ex. 7C024505E00 ou Tag 1.

Cliquez sur Search pour lancer le filtrage et le tri.

3. Pour afficher à nouveau tous les capteurs mémorisés, désactivez le filtre dans la boîte de 
dialogue Search et cliquez sur Search.

Ouvrir les infos capteur

1. Si vous voulez éditer les informations spécifiques du capteur, cliquez sur Open sensor 
information.

2. Les informations capteur sont affichées.

– Si vous voulez retirer un capteur du process, par ex. parce que ses mesures ne sont plus 
stables, vous pouvez le désactiver ici. Il est également possible de désactiver un capteur 
détruit sur le terrain.
Pour cela, cochez la case Active. La case est décochée et l'entrée devient No.

– Pour entrer un nom de Memoclip, cliquez sur le champ vide à côté de Label Memoclip.
Entrez les informations souhaitées.

– Pour entrer un commentaire, cliquez sur le champ vide à côté de User comment.
Entrez les informations souhaitées.

Cliquez sur Store data.
Les données éditées sont mémorisées comme une nouvelle entrée de la base de données avec 
horodatage.
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Ouvrir les statistiques

Les statistiques du capteur vous donnent une représentation graphique des données d'étalonnage 
du capteur. Vous pouvez voir immédiatement les variations du point zéro et de la pente du capteur 
et utiliser cette information pour déterminer les intervalles d'étalonnage du capteur.

1. Cliquez sur Open statistics.

2. Les statistiques du capteur sont affichées.

3. Si vous voulez fermer l'affichage graphique, cliquez sur Close statistics.

4. 8 Exporter des données
Memobase vous donne la possibilité d'exporter aussi bien des entrées individuelles que toutes les 
entrées d'un capteur défini ou l'ensemble des entrées de la base de données dans différents formats 
courants, par ex. Excel, HTML, etc. Vous pouvez ainsi intégrer sans problème les données capteur 
dans d'autres systèmes.

4.8.1 Exporter des données capteur
L'option d'exportation des données capteur permet d'exporter dans un fichier HTML les données 
du capteur qui vient d'être interrogé.

Pour lancer l'exportation des données capteur :

1. Cliquez sur l'onglet Sensor view.

2. Sélectionnez les entrées de la base de données que vous voulez exporter.
– Pour sélectionner plusieurs entrées successives, maintenez la touche Shift enfoncée et 

cliquez sur la première et la dernière entrée de la série.
– Pour sélectionner plusieurs entrées aléatoires, maintenez la touche Ctrl enfoncée et cliquez 

sur les entrées désirées.

3. Sélectionnez File > Sensor data export.

4. La boîte de dialogue Sensor data export s'ouvre.
– Sélectionnez le répertoire cible.
– Entrez un nom de fichier.
– Cliquez sur Save.

5. Les entrées de base de données sont sauvegardées dans le répertoire sélectionné sous forme de 
fichier HTML.
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4.8.2 Rapport du capteur
Le rapport du capteur exporte toutes les entrées relatives à un capteur donné dans un fichier XLS.

Pour créer le rapport du capteur :

1. Sélectionnez File > Sensor report.

2. Dans la boîte de dialogue qui s'ouvre, entrez le numéro de série du capteur pour lequel vous 
voulez établir un rapport.

3. La boîte de dialogue Create a sensor report s'ouvre.
– Memobase crée automatiquement un dossier avec le numéro de série sélectionné dans le 

répertoire C:\Programs\Endress+Hauser\Memobase\Reports.
– Entrez un nom de fichier.
– Cliquez sur Save pour sauvegarder le rapport dans le dossier créé automatiquement.

4. Le rapport du capteur est sauvegardé sous la forme d'un fichier XLS.
Il contient les informations suivantes :
– Toutes les données capteur
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– Une représentation graphique de l'historique de la pente

– Une représentation graphique de l'historique du point zéro



Memobase CYZ41D Configuration

Endress+Hauser 25

4.8.3 Exporter une base de données
L'option d'exportation d'une base de données permet d'exporter les entrées sélectionnées de votre 
base de données Memobase dans un fichier CSV.

Pour lancer l'exportation d'une base de données :

1. Cliquez sur l'onglet Database.

2. Sélectionnez les entrées de la base de données que vous voulez exporter.
– Pour sélectionner plusieurs entrées successives, maintenez la touche Shift enfoncée et 

cliquez sur la première et la dernière entrée de la série.
– Pour sélectionner plusieurs entrées aléatoires, maintenez la touche Ctrl enfoncée et cliquez 

sur les entrées désirées.

3. Sélectionnez File > Database export.

4. La boîte de dialogue Database export s'ouvre.
– Sélectionnez le répertoire cible.
– Entrez un nom de fichier.
– Cliquez sur Save.

5. L'entrée de base de données est sauvegardée dans le répertoire sélectionné sous forme de 
fichier CSV.
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5 Accessoires

5. 1 Communication
Commubox FXA291
• Module interface entre CDI et port PC USB
• Information technique TI405C
• réf. 51516983

5. 2 Transmetteur
Liquiline M CM42
• Transmetteur 2 fils modulaire pour les applications en zone Ex ou non Ex
• Hart®, PROFIBUS ou FOUNDATION Fieldbus possible
• Commande selon la structure de commande, Information technique TI381C

5. 3 Identification extérieure
Memoclip
• Identification pour capteurs Memosens
• 100 clips en matière synthétique avec planches d'étiquettes
• réf. 71038228
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